NOTE TO AUTHORS:
Sage Publications, Inc., our publisher, has recently changed the format for articles published in Qualitative Health Research (QHR). The following Guidelines reflect the changes required by the new article template. Because the template is new (and we are all learning the new rules), you might have questions that are not addressed in the Guidelines. If this is the case, please address your inquiries to QHR-TE@nurs.utah.edu; please do not send inquiries to other (or additional) QHR email addresses. You may also telephone 801-793-5714. Thank you for your cooperation.

The new Guidelines are effective immediately.
# Table of Contents

I. About QHR ................................................................................................................. 4  
   - About Qualitative Health Research (QHR) ....................................................... 5  
   - How to Contact Us ......................................................................................... 6  
   - Reviewers Needed ......................................................................................... 7  

II. Preparing Your Manuscript .................................................................................. 8  
   A. Writing to Publish in QHR ............................................................................ 9  
      - General Style .......................................................................................... 9  
      - Things to Avoid ....................................................................................... 9  
      - Word Choices ......................................................................................... 9  
      - Common Problems ............................................................................... 10  
      - Review Your Manuscript .................................................................... 10  
      - Prior to Submission ............................................................................. 11  
   B. Preparing Your Manuscript ........................................................................... 12  
      - Keep in Mind ......................................................................................... 12  
      - Confidentiality and Protection of Identity ........................................... 12  
      - Elements of a Manuscript ................................................................. 12  
      - Order of Elements ............................................................................... 13  
      - Document Setup and Formatting ...................................................... 13  
   C. Preparation of Required Manuscript Elements ............................................. 18  
      - Title Page ............................................................................................ 18  
      - Abstract .................................................................................................. 22  
      - Keywords ................................................................................................ 22  
      - Main Manuscript .................................................................................... 23  
      - References .............................................................................................. 28  
   D. Preparation of Optional Manuscript Elements ............................................... 30  
      - Appendixes ............................................................................................ 30  
      - Tables ....................................................................................................... 30  
      - Figures ..................................................................................................... 31  
   E. Instructions for Accepted Manuscripts ........................................................... 33  
   F. Sample Accepted Manuscript ....................................................................... 35  
   G. QHR Keyword List ....................................................................................... 40  

III. Book Reviews ........................................................................................................ 47  

IV. Guest Editorials ...................................................................................................... 50  

V. Submission, Review, and Publication .................................................................. 53
A. How to Submit a New Manuscript ................................................................. 54
B. How to Submit a Revised Manuscript ....................................................... 55
C. Review, Decision, and Revision Process .................................................. 56
D. Publish Ahead of Print ............................................................................. 58
E. Policy on NIH Publication Requirements ................................................. 59

VI. Permissions .................................................................................................. 60
A. Exclusive License to Publish ...................................................................... 61
B. Copyright Permission .................................................................................. 61
ABOUT QHR
ABOUT QUALITATIVE HEALTH RESEARCH (QHR)

Editor: JANICE M. MORSE, RN, PhD (ANTHRO), PhD (NURS), FAAN
University of Utah College of Nursing, Salt Lake City, Utah, USA

QUALITATIVE HEALTH RESEARCH, widely referred to as QHR, is an international, interdisciplinary, refereed journal for the enhancement of health care. Published monthly, it is designed to further the development and understanding of qualitative research methods in health care settings. The journal is an invaluable resource for researchers, practitioners, academics, administrators, and others in the health and social service professions, and graduate students who seek examples of qualitative methods.

COMPREHENSIVE, TIMELY COVERAGE FROM A VARIETY OF PERSPECTIVES

Issues of QHR provide readers with a wealth of information, including articles covering research, theory, and methods in the following areas:

- Description and analysis of the illness experience
- Health and health-seeking behaviors
- The experiences of caregivers
- The sociocultural organization of health care
- Health care policy
- Related topics

Articles in QHR examine an array of timely topics such as chronic illness; risky behaviors; patient–health professional interactions; pregnancy and parenting; substance abuse; food, feeding, and nutrition; living with disabilities; milestones and maturation; monitoring health; children’s perspectives on health and illness, and much more. In addition, the journal addresses a variety of perspectives, including cross-cultural health, family medicine, health psychology, health social work, medical anthropology, sociology, nursing, pediatric health, physical education, public health, and rehabilitation.

We also consider critical reviews; articles addressing qualitative methods; and commentaries on conceptual, theoretical, methodological, and ethical issues pertaining to qualitative inquiry.

PUBLISHER

QHR is published by Sage Publications, Inc., 2455 Teller Road, Thousand Oaks, CA 91320, USA; www.sagepub.com; telephone 800-818-7243.

[REV 3: AUG 09]
**How to Contact Us**

**Email:**

Editor, Dr. Janice Morse  
QHR-Editor@nurs.utah.edu

Technical Editor, Dori Fortune  
QHR-TE@nurs.utah.edu

Journal Editorial Office  
QHR-Journal@nurs.utah.edu

**DO** – send all QHR-related email messages to *only one* of the email addresses listed above.

**Do NOT**

– send email messages to two or more addresses simultaneously; doing so will cause a significant delay in the QHR response.

– send email messages to "personal" or University email accounts of QHR personnel, such as "janice.morse@..." or "dori.fortune@..." Sending messages to addresses other than those listed above will cause a significant delay in the QHR response.

**Telephone and Facsimile (Fax):**

Phone 801-793-5714

Fax 801-355-3850

Attention: Dori Fortune

**DO** – direct all manuscript-related faxes to Dori Fortune.

**Mailing Address:**

Janice Morse [or Dori Fortune, as appropriate]
Qualitative Health Research
University of Utah College of Nursing
10 South 2000 East
Salt Lake City UT 84112-5880 USA

**DO** – direct all manuscript-related documents to Dori Fortune.
Reviewers Needed

Reviewers must have a strong background in qualitative health research and/or qualitative methods. They must have a willingness to share their expertise by evaluating manuscripts and providing feedback for authors to assist them in strengthening their articles.

What’s in it for you?
You have the prerogative of reading prepublication articles in your methodological or substantive areas, and assisting in molding the literature in your field. Also, we give you copies of the other reviews received, so you can review the general consensus about the decision, and in doing so improve your own research, reviewing, and writing skills.

Do you have to have a doctorate?
No—but if you are a doctoral student we recommend that you do the first few reviews jointly with your supervisor or some other experienced reviewer, so you can learn the “ins and outs.”

Qualitative Health Research (QHR) is an international journal published monthly by Sage Publications. Research articles, developments in qualitative methods, and Pearls, Pith, and Provocation—discussion articles on qualitative ethics and other issues—are reviewed. Keynote addresses, editorials, and book reviews are also published.

If you would like to join the review board for QHR, please email your curriculum vitae (CV) and complete contact information to QHR-TE@nurs.utah.edu.

Thank you! We look forward to hearing from you!

Janice M. Morse
Editor
PREPARING YOUR MANUSCRIPT
WRITING TO PUBLISH IN QHR

Review this entire document prior to preparing and submitting your manuscript.

GENERAL STYLE

Authors considering submission to QHR should first be familiar with the journal, the types of articles we publish, and our readership. Read several recent articles published in the journal prior to submitting your work, and consider whether your manuscript is a good “fit” for the journal.

In general, QHR adheres to the requirements of Sage Publications, Inc., and the guidelines contained in the Publication Manual of the American Psychological Association ["APA"], 5th edition (ISBN 1-55798-791-2), with regard to manuscript preparation and formatting. [Elsewhere in these Guidelines this book is referred to as the APA Publication Manual, or just APA.] Additional help may be found online at http://www.apa.org/, or search the Internet for “APA format.”

Many universities and private organizations have Web sites devoted to APA style. However, when guidelines found on those sites, or in the APA Publication Manual, conflict with QHR Guidelines, you must follow the QHR Guidelines.

Proper formatting will speed the peer-review process for your manuscript, and will facilitate a smoother production process if it should be selected for publication. Refer to the guidelines below, and to APA.

Improper formatting could result in burdensome revisions, lengthy delays in the review and production processes, and the possible rejection of your manuscript.

The next three (3) sections—Things to Avoid, Word Choices, and Common Problems—are a matter QHR journal style, and are not subject to author preference; adherence is required.

THINGS TO AVOID

- Anthropomorphism (for example, neither studies nor articles think, explore, or design)
- Back-to-back parentheses [incorrect: (xxx)(yyy) / correct: (xxx; yyy)]
- Ellipses ( . . . ) indicating pauses in speech (except as appropriate in conversation analysis)
- Inclusion of irrelevant data
- Inconsistent writing style (especially with two or more authors)
- Paragraphs longer than one, double-spaced manuscript page
- Referring to an article as a study, and vice versa
- Repetition
- Tables listing participants and their demographic characteristics
- Use of the words “importantly” and “interestingly” (it should all be important and interesting)
- Very long or “wordy” sentences
- Writing in third-person passive voice

WORD CHOICES

It is always best to use the most precise language possible to convey important data, concepts, and findings. Because QHR is an international journal published in U.S. English, there is the added need to avoid commonly-used English terms (colloquialisms, slang) that might be misinterpreted by or confusing to readers whose first language is not English.

<table>
<thead>
<tr>
<th>Word</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>feel</td>
<td>It is appropriate to use this word when referring to a physical sense or state of mind; do not use it when your intent is think or believe.</td>
</tr>
<tr>
<td>further</td>
<td>This word is appropriately used when referring to distance. At the beginning of a new sentence, when writing of something in addition to something already stated, it is more appropriate to use furthermore, moreover, in addition, or additionally.</td>
</tr>
<tr>
<td>may</td>
<td>It is a common mistake to use this word in place of might. May conveys permission, might conveys possibility, and can conveys ability. Use each word as appropriate.</td>
</tr>
</tbody>
</table>
over  Be careful not to use this word when the intended meaning is more than.

since  Since is the appropriate word to use when referring to the passage of time; avoid using it when the intended meaning is because.

U.S./United States  Use U.S. only as an adjective; in all other instances, spell out United States. The same rule applies to U.K./United Kingdom.

While/whilst  Use while when referring to concurrent events; do not use it when your intent is whereas, although, or even though. Do not use whilst.

Instead of this . . .  Use this . . .

amongst  among
as regards  with regard to; regarding
can’t, don’t, and so forth  cannot, do not, and so forth
Caucasian  White
due to  because of
etc.  and so forth
firstly, secondly, thirdly  first; second, third
in order to  to
paper  article
towards  toward
upon  on
whilst  while (but see consideration, above)

COMMON PROBLEMS

Acronyms  The full spelling of the related words must precede the first usage of an acronym (even if you think everyone knows what the acronym stands for), followed by the acronym in parentheses; e.g., World Health Organization (WHO). Thereafter you may use the acronym alone: WHO. Avoid the overuse of multiple acronyms.

Capitalization  Capitalize proper names; do not capitalize words unnecessarily, such as titles and ranks; e.g., director, professor, doctor, chairperson, and so forth.

Hyphenation  Refer to the APA Publication Manual, 5th edition, for an excellent explanation of the proper use of hyphens and dashes; do not depend on Word’s “Spell Checker” feature for decisions on hyphenation.

With few exceptions (see APA), words beginning with pre, post, non, semi, and socio do not require hyphenation.

Spacing  Use no spaces before, and only a single space after periods (.), commas (,), colons (:), semicolons (;), question marks (?), and closing quotation marks (”). Use no spaces after opening quotation marks.

Title Case  Title case is properly created by capitalizing:

- the first letter of the first word
- the first letter of the first word after a colon (:) or em dash (—)
- all important words, and
- all words containing four or more letters

“REVIEW” YOUR MANUSCRIPT

One common reason for “revise” decisions is that authors are sometimes so immersed in their data and findings that they lose track of:

- whether the information presented contributes new knowledge
- whether the appropriate method and design have been used
- whether ethical standards have been met
- whether the information is presented in a complete, concise, and logical manner, with attention to writing style, and
what the reader needs/wants to know (remember that QHR readers have expertise in diverse areas, and therefore many will not be familiar with concepts and terminology common to your research area)

Before submission, we recommend an informal peer review of your article, using these criteria:

<table>
<thead>
<tr>
<th>Importance of submission</th>
<th>What are the manuscript’s strengths? Is it significant? Does it contain new and unique information?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theoretical evaluation</td>
<td>Is the manuscript logical? Is the theory parsimonious? Complete? Useful?</td>
</tr>
<tr>
<td>Methodological assessment</td>
<td>Inductive approach? Appropriate method and design? Is the sample appropriate and adequate? Are data saturated? Theoretical analysis? Linked with theory and/or praxis?</td>
</tr>
<tr>
<td>Adherence to ethical standards</td>
<td>Does the manuscript (and the study on which it was based) adhere to ethical standards?</td>
</tr>
<tr>
<td>Manuscript style and format</td>
<td>Evaluate writing style, organization, clarity, grammar, appropriate citations, and so forth. Is the manuscript unnecessarily long?</td>
</tr>
</tbody>
</table>

PRIOR TO SUBMISSION

- Make sure your entire manuscript is prepared in accordance with these Guidelines in every respect (required).
- Have your manuscript professionally edited by a native English-speaking editor. This is especially important if English is not your first language. Remember to inform your editor of the need to use U.S.-English spelling, and provide him or her with a copy of these Guidelines.
- Proofread your manuscript aloud; doing so will help you identify awkward phrasing, run-on sentences, incomplete sentences, improper punctuation, missing text, and much more. We recommend that the corresponding author and all coauthors proofread the entire manuscript (including abstract and references) from a paper copy rather than a computer screen.
PREPARING YOUR MANUSCRIPT

If you still have questions after carefully reading these instructions, please refer to the samples provided before contacting the QHR office.

KEEP IN MIND . . .

- *Qualitative Health Research* is a peer-reviewed journal. Only complete, finished manuscripts should be submitted for consideration.

- It is preferred that you write both the abstract and the text of your manuscript in *first-person active voice*; however, this is not a requirement. If you choose to write otherwise, ensure that the abstract and manuscript “match” in voice.

- *We do not publish* stand-alone abstracts, quantitative studies, manuscript outlines, pilot studies, manuscripts-in-progress, letters of inquiry, or literature reviews. Research articles must be pertinent to health.

**Do NOT** — send query letters/email messages: After ensuring that your manuscript complies fully with these Guidelines, the only way to determine if the manuscript is suitable for QHR is to submit it for consideration.

CONFIDENTIALITY AND PROTECTION OF IDENTITY

QHR is committed to protecting the identity and confidentiality of research study participants. With the exception of participatory action research (PAR), no information that could potentially allow identification of a participant—or even a specific study site—should be included in a submitted manuscript or, subsequently, included in a published article.

If the use of participant names is absolutely necessary for reader understanding, each study participant referred to in the manuscript should be assigned a pseudonym. Study sites, such as hospitals, clinics, or other organizations, should not be named, but instead should be described; for example: “Study participants were recruited from the coronary care unit of a large metropolitan hospital on the eastern seaboard of the United States.” Authors who include participant names and/or photos must submit (at the time the manuscript is originally submitted) written permission from the participants to do so—no exceptions.

During the review process, author citations in the text should include only the word “Author” and the year: *(Author, 2008)*. Author references in the reference list should also include only the word “Author” and the year: *Author (2008)*.

**Do NOT** — include participant identifiers (name, pseudonym, age, and so forth) except to identify a particular category of respondent (e.g., males age 18 to 24; community professional; psychologist; and so forth), and even then, include identifiers only when necessary for reader understanding.

- include author information, author references (except as described herein), authors’ notes, or acknowledgements in the main manuscript document. Manuscripts submitted to *Qualitative Health Research* are “blind” reviewed.

- in author references, include the article/book title, journal name, or any other part of the reference.

- place the author reference in alphabetical order in the reference list; place it at the beginning or the end of the reference list. If and when the manuscript is accepted for publication, the missing information can be restored and placed in the proper order.

ELEMENTS OF A MANUSCRIPT

*Note: Samples of most of the following elements are provided in this section.*

*Note: Some instructions differ for accepted (accepted, pending revision) manuscripts; please refer to the separate section on accepted manuscripts, below.*
The following elements are **required** for each manuscript, and should be compiled in the following order:

1. **Title page**  
   Submit the title page as a *separate document*

2. **Abstract**  
The abstract is placed on p. 1

3. **Keywords**  
Place the keywords below the abstract, on the same page. Leave a (double-spaced) blank line between the abstract and the keywords.

4. **Main manuscript**  
The main text of the manuscript begins on p. 2

5. **References**  
References begin on a new page, after the end of the manuscript text, or after the notes, if any (do not submit references as separate documents).

The following elements *may* be included in your submission (they are **optional**):

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notes</strong></td>
<td>Place notes (also known as endnotes or footnotes) after the main text, before the first page of references.</td>
</tr>
<tr>
<td><strong>Tables</strong></td>
<td>Place tables, <em>one per page</em>, at the end of the main manuscript document, after the references (do not submit tables as separate documents).</td>
</tr>
<tr>
<td><strong>Figures</strong></td>
<td>Submit each figure in a <em>separate document</em>, in order, by number.</td>
</tr>
<tr>
<td><strong>Appendixes</strong></td>
<td>Appendixes are published only at the editor’s discretion. Place any appendixes after the reference list, and before any tables.</td>
</tr>
</tbody>
</table>

**ORDER OF ELEMENTS**

Compile the elements of your main manuscript document in the following order. Each element (except notes) should begin on a new page:

1. Abstract and keywords (required)
2. Main manuscript text (required)
3. Notes (if any)
4. References (required)
5. Appendixes (if any)
6. Tables (if any)

**DOCUMENT SETUP AND FORMATTING** (See also sample manuscript pages)

- **Document file type**: Submit only documents created in Microsoft Word, and only with the regular file extension of .doc; *Word documents with “.docx” or “.rtf” extensions, .PDF files, or other types of documents will not be accepted for consideration.*
- **Paper size**: Letter, 8.5” x 11” (the “ symbol = inches), with portrait orientation
- **Margins**: 1” on all sides
- **Line numbers**: None
- **Line spacing**: Exactly “double,” with 0” before and 0” after

**Note:** The various elements of manuscript setup are listed in alphabetical order.

**Ellipses / ellipsis points**  
Almost every manuscript contains ellipses. They are used to indicate missing words in quotations, and are to be created in a very specific manner.

The proper way to create ellipsis points is as follows: Three (3) dots, preceded, divided, and followed by spaces, like . . . this.

If it is necessary to indicate missing words *between sentences* (instead of in
mid-sentence), place a period (full stop) at the end of the first sentence, then format the ellipsis points as noted, and begin the next sentence (with a capital letter) immediately after the last space. . . . Like this.

*Do NOT* – use the "Insert > Symbol" function in Word to enter ellipses.
– use ellipses to indicate pauses in speech.
– place ellipses within parentheses ( . . . ) or brackets [ . . . ]; the exception to this is in conversation analysis, as appropriate.

**Font size, text**
Use 10-point font for regular text, section headings, conversation analysis (if any), abstract and keywords, references, notes, and quotations.

**Font size, tables and figures**
Use only 8- or 9-point font in tables and figures.

**Font style, conversation analysis (CA)**

*Note: This specific instruction does not pertain to normal quotations, excerpts, or block quotes.*

Courier style font should be used for sections containing conversation analysis (if any). Retain the conversation analysis sections in the desired location among the regular manuscript text, and *do not set them as figures, in a box, or as excerpts/block quotes.* Use the following steps to apply (required) special formatting to the CA text only:

1. Set your font at 10 points, Courier style.
2. Set your margins (*only for the sections with this special text*) at 1” on the left, and 4.55” on the right, so the available print area is 2.95” wide, flush left.
3. The line number, participant pseudonym (or other speaker identification, if any), and transcribed text will need to fit across the 2.95 inches of printable line space. This is to ensure that the text will fit within the column format of the printed journal.
4. Manipulate your text within this space until you have achieved the desired alignment for all lines.
5. If your article is accepted, be sure to examine the publication proof of the conversation analysis sections very carefully to confirm that the text is set and aligned correctly.

*Note:* If desired, instead of using the above formatting, you may place your sections of CA within text boxes that are formatted to fit within a single column of journal space (see above), and manipulate text within the text box until you have achieved the desired alignment for all lines. The text box(es) should then be put in place within the manuscript text. Be sure to label your CA excerpt with a level-1, Gill Sans heading *inside* the top of the text box (i.e., *Excerpt 1*).

*Do NOT* – use this format if you have not conducted conversation analysis (CA).
– attempt to achieve margin formatting with tabs and hard returns; use Word’s formatting features in Page Setup.

**Font style, headings, title page, figures, and tables**
Use Gill Sans font for all of these. This includes figure/table numbers, titles, text within the figures/tables, and citations or explanatory notes below the figures/tables (if any).

**Font style, main manuscript**
Use Times New Roman font for the main body text (see above for information on font style for headings, title page, tables, figures, and so forth). Also, use Times New Roman font for the text (not the headings) of acknowledgments, author’s notes, declarations of conflicting interests, funding statements, and
bios.

*Italics* should be used only:

1. as appropriate in the reference list (see APA);
2. as appropriate in level-2, -3, and -4 headings; and
3. to introduce non-English words, or *unusual* new concepts (2 to 3 words), and then only when the new word or concept is first introduced in the manuscript; subsequent use of the same word(s) should be in regular Roman font.

---

**Do NOT**

- use *italics* for emphasis.
- use *italics* for quotations (long or short).
- use **bolding** except for level-1 headings, as appropriate (see below).

---

**Headings**

All headings, without exception, are to be set in *Gill Sans, 10-point font*.

**Do NOT** – follow APA guidelines for headings; format your headings only as described below.

**QHR** uses 4 distinct levels of headings (H = Heading), including:

<table>
<thead>
<tr>
<th>H Level</th>
<th>Formatting (all headings should be double-spaced, just like the text)</th>
</tr>
</thead>
<tbody>
<tr>
<td>H1</td>
<td><strong>Flush Left, Bold Text, in Title Case</strong></td>
</tr>
<tr>
<td>H2</td>
<td><strong>Flush Left, Italicized Text, in Title Case</strong></td>
</tr>
<tr>
<td>H3</td>
<td><strong>Flush left, italicized text, in sentence case, ending with a period.</strong> At this level, the paragraph text begins immediately after the heading, instead of on the next line. The heading is part of the paragraph.</td>
</tr>
<tr>
<td>H4</td>
<td><strong>Indented (.5”), italicized text, in sentence case, and ending with a period.</strong> At this level, the paragraph text begins immediately after the heading, instead of on the next line. The heading is part of the paragraph.</td>
</tr>
</tbody>
</table>

Use at least two heading levels:

- For manuscripts with 2 heading levels, use H1 and H2
- For manuscripts with 3 heading levels, use H1, H2, and *not* H3
- For manuscripts with 4 heading levels, use H1, H2, H3, and H4

---

**Justification of margins**

All text should be *left justified*.

**Do NOT** – use full justification for any portion of your manuscript. The text at the right-hand margin should be uneven (irregular).

---

**Length of manuscript**

There is no predetermined word or page limit. Provided they are “tight” and concise, without unnecessary repetition and/or irrelevant data, manuscripts should be as long as they need to be.

The editor might require a reduction in length if the manuscript contains material that does not add anything useful to the topic being discussed.

Limits might be imposed on the number/size/length of tables, figures, reference lists, and appendixes.

**Line spacing**

*Everything, in all elements of the manuscript*, from the title page through the references and tables (if any), must be exactly double spaced. Exception: Text within a figure should be single spaced.
To set double spacing, go to Format > Paragraph > Line spacing > Double. (Note that the “Before” and “After” settings should both be “0 pt”.)

**Do NOT**
- create double spacing with hard returns (by striking the “enter” key twice).

**Paragraphs**
Paragraphs are to flow, one after the other, without additional line breaks (with few exceptions; see below).

**DO**
- leave a blank (double-spaced) line between the abstract and the keywords (create the blank line by hitting “enter” twice).
- leave a blank line after each block quote/excerpt.
- leave a blank line between block quotes/excerpts if you have placed two or more in succession.
- leave a blank line after each numbered or bulleted list, and after each section of conversation analysis.

**Do NOT**
- leave blank lines before block quotes/excerpts, numbered or bulleted lists, or sections of conversation analysis.
- leave blank lines between paragraphs (with the exceptions of after block quotes/excerpts, bulleted or numbered lists, or sections of conversation analysis; see below).
- add any special formatting to the document, such as increased line space before and/or after headings.
- use 1-sentence paragraphs.

Indent the first line of every new paragraph by .5”, except:

**Do NOT**
- indent the first line of the abstract or the keywords.
- indent the first (opening) paragraph of the manuscript text.
- indent paragraphs immediately after level-1 and level-2 headings.
- indent paragraphs beginning with level-3 headings.
- make indentations using tabs.
- use two, .25” indentations.
- change margins to create the indentations.

**DO**
- use Word’s Format > Paragraph function to set paragraph first-line indentations.
- use Word’s Format > Paragraph function to set block quote/excerpt and bulleted/numbered list indentations; note that block quotes/excerpts and lists are to be completely indented by .5” (not just the first line).

**Quotation marks**
In general, use double quotation marks (e.g., “Xxxx.”) to set off quotations appearing within regular paragraphs, and to set off words being used with “special” meaning (or unusual spelling to convey special meanings within the text; e.g., “busy-ness”).

In regular paragraphs, use single quotation marks to set off a quote within a quote (e.g., “Xxx, ‘Yyy,’ xxxx.”).

**DO**
- note that when closing quotation marks coincide with a comma or period (full stop), the quotation marks go outside (after) the comma or period: “Quotation. . . last word.”
**Do NOT** – use any quotation marks for block quotes *unless* there is a separate, shorter quote contained within the larger quote; in such a case, use double quotation marks (e.g., Xxxxx, “Yyyy,” xxxx.) only for the “inner” quote.

**Quotations**

Quotations of 40 or more words should be set as separate paragraphs, with the entire quotation indented .5 inches from the left margin (this is also referred to as a “block quote” or “excerpt”).

Some quotations of fewer than 40 words may also be set separately for uniformity of appearance. All other quotations should be contained within regular paragraphs, along with regular text.

**DO**

– format the indentation for block quotes with Word’s Format > Paragraph feature.

**Do NOT**

– format the indentation for block quotes with tabs.

– change the margins for block quotes (margins should remain at 1” on all sides).

– use italics for quotations.

**Seriation**

Seriation refers to “numbered” lists appearing in a sentence of regular text (in other words, not in a vertical list).

The proper seriation style for manuscripts submitted to *QHR* is (a), (b), (c), and so forth.

**Do NOT**

– use numbers of any type for in-text seriation.

**Spelling**

The spelling of English words varies among the many English-speaking cultures and countries of the world. *QHR* is published in **U.S. English**.

Use Word’s spell check feature to ensure that you have used U.S.-English spellings throughout your manuscript.

Exceptions to this include (a) direct quotes from written, published material, and (b) titles in the reference list (which should be spelled exactly as published).
PREPARATION OF REQUIRED MANUSCRIPT ELEMENTS

A maximum of four (4) types of documents should be submitted: (a) title page; (b) main manuscript; (c) figures (if any); and (d) permissions (if needed). Despite what the online submission system (ScholarOne Manuscripts / Sage Track) might allow, do not submit such elements as abstracts, references, and tables as separate documents.

TITLE PAGE

See the sample title page, below.

The title “page” may be longer than one page. To retain author anonymity during peer review, it is submitted as a separate document. Title page information should not be included in the main manuscript document.

The title page should include the following, in this order:

<table>
<thead>
<tr>
<th>Text for a running header</th>
<th>This is an abbreviated title of your article. It must be no more than 40 characters + spaces in length, total.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Place the running header on the title page only, and do not include it in the main manuscript.</td>
</tr>
</tbody>
</table>

**Do NOT** — actually format a running header.

<table>
<thead>
<tr>
<th>Article title</th>
<th>A title should convey, as clearly and succinctly as possible, the main idea, focus, or content of a manuscript. It should be clear in meaning even when standing alone.</th>
</tr>
</thead>
</table>
| **DO**        | – make your title 10 to 12 words (or fewer) in length.  
|               | – avoid long or “wordy” titles.  
|               | – avoid titles with colons or quotations unless they are necessary to convey an important concept or idea in the article.  
|               | – type your title in Title Case; this means:  
|               | * capitalizing the (first letter of) the first word  
|               | * capitalizing all important words  
|               | * capitalizing all words that have four (4) or more letters (no exceptions)  
|               | * capitalizing the first word after a colon or em (long) dash |

**Do NOT** — type your title in ALL CAPITAL letters (this is especially important when entering the article title in the ScholarOne Manuscripts / Sage Track system).

| Author names | List the name (not just initials) of each author, without credentials, in order, horizontally across the page.  
|--------------|--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
|              | If there are two authors, list them as: Author One and Author Two  
|              | If there are three or more authors, list them as: Author One, Author Two, Author Three, and Author Four (and so forth)  
|              | After each name (or after the comma following a name, if applicable), use a superscript number to link that particular author with his or her affiliation (see the section on author affiliations, below).  

---

18
Author affiliations

Using the same superscript numbers as used with the authors’ names (see above), list the primary affiliation of the authors:

1 University of ABC, City, State (or province), Country
2 University of XYZ, City, State (or province), Country
3 General Hospital, City, State (or province), Country

**DO**

- spell out all city, state, and country names (exception: use USA instead of United States).
- spell out any organization or institution names (for example, University of Utah instead of U of UT, or World Health Organization instead of WHO).

**Do NOT**

- list secondary or additional affiliations on the title page.
- use abbreviations (except USA).
- include department or division names, or secondary unit names on the title page.

Contributing author information

Use only the following format for the corresponding author, and do not include any information that is not listed below. List information only for the individual who should be contacted by readers after (if) the article is published. Example:

Author S. Name, university or institution/agency name, name of school (or college, department, or division), city, state (or province, if any; you may use abbreviations for these), zip (or postal) code, country (spelled out, except for USA) [Note that this first part is written as one continual line, using commas as separators, and with no ending period]

Email: author.name@address.ext [Note that the email address is on a separate line]

Acknowledgments

This is optional. The section is limited to two (2) or three (3) brief sentences. Overlong acknowledgments will be reduced at the copyeditor’s discretion. Do not include long descriptions of persons being acknowledged, and do not include credentials.

Avoid phrases such as we wish to thank, we would like to thank, and we want to thank, and just use a simple, we thank, or we acknowledge.

Author’s / Authors’ note

This is optional. This is the place to note, perhaps, that portions of the article were presented at a professional meeting, or other information of that sort.

Declaration of conflicting interests

You must include one of the following statements (in these exact words):

The author(s) declared no conflicts of interest with respect to the authorship and/or publication of this article.

or

The author(s) declared a potential conflict of interest (e.g., a financial relationship with the commercial organizations or products discussed in this article) as follows: [List specific author relationships with organizations and/or products that were declared].

Funding

You must include one of the following statements (in these exact words):

The author(s) received no financial support for the research and/or
authorship of this article.

or

The author(s) disclosed receipt of the following financial support for the research and/or authorship of this article: [List the entities that funded the research and/or authorship].

Bios

Bios are simple and concise, 1-sentence biographical statements about each author. Long bios will be reduced by the copyeditor. In this space you may include department or division names, and secondary affiliations (if any). Use only the following format for your bios:

Janice M. Morse, PhD, RN, FAAN, is a professor and presidential endowed chair at the University of Utah College of Nursing in Salt Lake City, Utah, USA.

Credentials and current positions (or affiliations or professional pursuits) are required.

See the sample title page on the following page.
Running Head: Short Title of the Article

Article Title, Set in Title Case

Janice M. Morse¹ and Author N. Two²

¹ University of Utah, Salt Lake City, Utah, USA
² ABC University, Anytown, Any Province, Canada

Corresponding Author:

Janice M. Morse, University of Utah College of Nursing, 10 S 2000 E, Salt Lake City, UT 84112 USA

Email: QHR-Editor@nurs.utah.edu

Acknowledgments

We thank our research assistants, name, name, and name for their invaluable contributions to the study.

Authors’ Note

Portions of this article were presented at the 10th Annual Health Care Conference, August 1, 2009, in Salt Lake City, Utah.

Declaration of Conflicting Interests

The authors declared no conflicts of interest with respect to the authorship and/or publication of this article.

Funding

The authors received no financial support for the research and/or authorship of this article.

Bios

Janice M. Morse, PhD, RN, FAAN, is a professor and presidential endowed chair at the University of Utah College of Nursing in Salt Lake City, Utah, USA.

Author N. Two, MPH, is an assistant professor in the Department of Health Research at ABC University in Anytown, Any Province, Canada.
**ABSTRACT**  See the sample abstract page, below.

The abstract should be placed on page 1 of the main manuscript document. It should be a single paragraph, no more than 150 words in length, and briefly describe your article.

| **DO** |  – double space the entire abstract page (including keywords).
|        |  – briefly state the purpose of your research, the main findings, and your primary conclusions.
|        |  – make sure that the abstract and manuscript “match” with regard to voice; for example, first-person active voice.

| **Do NOT** |  – include the manuscript title on the abstract page.
|            |  – indent the first line of the abstract.
|            |  – include citations.
|            |  – show the word count.
|            |  – repeat the text of the abstract in the main manuscript text.

**KEYWORDS**  See the sample abstract page and the *QHR* Keyword List, below.

Your keywords are words related to the article topics that readers or researchers could search on to find the article (if published).

Keywords should follow on the same page as the abstract. Leave a blank, double-spaced line between the abstract and the keywords.

Include all desired keywords *selected only from the QHR Keyword List*. List them exactly as they are shown in the keyword list, in lowercase letters (except for proper names), horizontally across the page, in the order in which they appear on the keyword list. Try to select at least five keywords.

Individual keywords should be separated by semicolons; note that some keywords are actually two or more words, and might include commas. Do not add a period (full stop) at the end of the keywords.

You may request that new keywords be added to the list, but the words should be general in nature, and not specific to a narrow topic. New keywords will be added at the editor’s discretion.

**See the sample abstract on the next page.**
Sample abstract page:

**Abstract**

Begin your abstract flush left at the top of the page, immediately below the abstract heading; do not indent the first line. The abstract may be up to 150 words in length. The entire abstract should be contained within a single paragraph. Do not add section headings or break the abstract into sections. Do not include citations in the abstract. Do not show the word count. Do not repeat the text of the abstract in the main manuscript text.

**Keywords**

[these are examples] cancer; cancer, breast; cancer, psychosocial aspects; embodiment/bodily experiences; lived experience; women’s health

**MAIN MANUSCRIPT**

See the sample main manuscript, below. Note that the sample manuscript is abbreviated for illustration purposes, and might not contain all optional elements that could be included in an actual manuscript. The sample uses all four heading levels.

The main text of the manuscript begins on page 2 of the document, immediately after the abstract page. We prefer articles written in the first-person active voice, but will consider articles written in the third person provided the voice of the abstract and manuscript match (see Abstract, above).

The main text of the manuscript should be broken into appropriate sections by the use of section headings. Sections should flow in a logical sequence, and include, at a minimum, **Methods**, **Results**, and **Discussion** (these are all level-1 headings); other level-1 headings and subheadings may be used at the author’s discretion. The author may choose to use different names for the three main sections, but the basic content should be that which would appropriately fall under the headings of **Methods**, **Results**, and **Discussion**.

There are very specific guidelines for the use and formatting of in-text citations; refer to the *APA Publication Manual, 5th edition*, for details (the specific edition is very important). Every in-text citation should have a corresponding reference in the reference list—no exceptions.

During the review process, author citations should include only the word Author and the year: (Author, 2008). If and when the manuscript is accepted for publication, the missing information can be restored.
**DO**

- double space the entire manuscript document—*no exceptions*.
- use only U.S.-English spelling (except in the references, as appropriate, and for direct quotations from written sources).
- use U.S.-English translations of non-English quotations or excerpts.
- attend to copyright regulations (*required*).
- use a *minimum* of two (2) heading levels.
- see *Preparing Your Manuscript*, above, for specific instructions on formatting the various elements within your main manuscript document.
- submit, at the time of manuscript submission, written permission for the use of any photographs, or copyrighted tables, figures, and/or text; written permission must come from the person(s) depicted in the photographs, or in the case of copyrighted work, from the copyright holder (who is not necessarily the author).

**Do NOT**

- include the manuscript title in the main document.
- include any author-identifying information in the main document.
- include any participant-identifying information (exception: participatory action research [PAR]).
- include names of specific study sites (hospitals, organizations, small towns or villages).
- use *any* headings (such as “Introduction” or “Background”) at the beginning of the manuscript.

Sample main manuscript document (references are shown below, in the next section):

Begin the opening paragraph flush left at the top of the page. Do not indent the first line of the opening paragraph. Xxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxx (citation, year). Xxxxxxx

xxxxxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxx xxxxxxxxxxxxxxxx

xxxxxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxx

xxxxxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxx

After the opening paragraph, indent the first line of all new paragraphs (those that do not follow headings) by .5 inches. Create this indentation by formatting the paragraph style (Format > Paragraph); do not indent the line with the tab key. Do not leave line breaks between paragraphs. Instead, continue with regular double spacing. Xxxxxxx xx x

xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx x xxxxxxxxxxxxxxxxxxx

xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx
xxxxx xxxxxxxxxxx xxxxx. Place headings immediately below the preceding paragraphs, with no additional line breaks.

**Level-1 Heading**

Begin the next paragraph immediately after the heading. Level-1 headings are set flush left, bolded, in title case, and Gill Sans font.

Xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
indented by .5 inches (the first line is not indented further). Indent the quote by using Word’s Format > Paragraph function. You may also format the indentation by highlighting the desired text, and clicking on the “Increase Indent” icon on the toolbar; do not use tabs to prepare block quotes.  

Do not use quotation marks with excerpts. The text of the block quote should be in the same font style and size as the regular manuscript, and should not be italicized. Leave a blank line after each block quote/excerpt. Leave a blank line between excerpts if you present two or more in a row.

Level-3 heading. Level-3 headings are set flush left, italicized, in sentence case, in Gill Sans font, and followed by a period. They follow immediately after the preceding paragraph, without additional line breaks. Note that the paragraph text begins immediately after the heading, on the same line.

Level-1 Heading

Level-2 Heading
Level-3 heading. Xxxxxxxxxxxxxxxxxxxxxxxxxxx. Xxxxxxxxxxxxxxxxxxxxxxxxxx Xxxxxxx
xxxxxxxxxxxxx xx xxxxxxxx xxxxxxx xxxxxxxxxxxxxxxx xxxxxxxxxxxxxx.

Level-4 heading. Level-4 headings are indented by .5 inches, italicized, in sentence
case, in Gill Sans font, and followed by a period. Note that the text of the first paragraph
under this heading follows immediately after the heading, on the same line, rather than
beginning on the next line. Xxxxxxxxxxxxx xxxxxxxxx xxxxx x xxx xxxx xxxxxxxx.

Notes

1. Text of first note. Do not format numbered bullets. Simply type the number, followed by a
   period and a space. You may include properly formatted citations in the notes, as appropriate.
2. Text of second note. Remember to include a corresponding superscript number in the text
   (after the ending punctuation, please) for each footnote.
3. Text of third note (and so forth). Do not use Roman numerals for footnotes.
REFERENCES

See the sample reference list, below. The sample does not show actual reference types.

Proper formatting of the reference list is the responsibility of the author.

The reference list (also known as a bibliography) should include complete references for the sources used in the preparation of your manuscript. Every reference should be cited in the text.

You must cite and reference pertinent articles published in QHR in the 12 months immediately preceding submission of your manuscript. If you cannot identify articles related to the topic(s) of your manuscript, please broaden your search to include method, research design, and so forth. If your article is accepted, and it has been several months since the initial submission, you might be asked to update all references prior to publication; this will include references published in QHR in the 12 months immediately preceding acceptance.

The reference list should begin on a separate page (not in a separate document) following the last page of manuscript text (or after the notes, if any). Each type of reference (journal article, book, chapter in edited book, computer software, newspaper, online reference, and so forth) must be formatted in accordance with the precise guidelines contained in APA.

Elements such as spelling, punctuation, spacing, capitalization, and the use of italics or Roman (regular) font are as important as the content of the reference.

(Note that if an author has two or more initials, there should be spaces between the initials; incorrect = X.Y.Z.; correct = X. Y. Z.).

References should be listed in hanging paragraph format (with indentations at .5”), in alphabetical order by the last name of the first author; additional considerations might apply (see APA). The hanging paragraphs should be created by using Word’s Format > Paragraph feature.

Author references in the reference list should include only the word “Author” and the year: Author. (2008). To prevent author identification during the review process, do not include the article title, journal name, or any other part of the reference. If and when the manuscript is accepted for publication, the missing information can be restored.

Avoid the use of unnecessary references and lengthy reference lists. Extensive bibliographies will not be published; articles should include only the “essential” or key references. If the author wishes to offer a secondary reference list (for example, references used in meta-analysis), it should be so stated in the Author’s Note, and made available to readers by contacting the author directly; do not include it in the manuscript document, but it may be submitted separately for purposes of review.

DO

– use only the 5th edition of the Publication Manual of the American Psychological Association (APA) as your source of instruction for references (this is critically important).

– format the hanging paragraphs with Word’s Format > Paragraph feature.

– translate non-English titles into English (see APA for instruction on how to do this).

– reference and cite all other studies mentioned in the article.

– reference and cite all computer programs or computer software mentioned in the text.

– test all Internet URLs (Web addresses) immediately before submission to ensure that they are accurate, and that the sites are still accessible; do this prior to submission of all revisions and accepted manuscripts, as well.

Do NOT

– format the hanging paragraphs with hard returns (“enter”) and tabs.

– submit the reference list as a separate document (except for lists such as meta-analysis references, as noted above).
Sample reference list:

References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (with .5" indentation). Use Format > Paragraph rather than using tabs to create the hanging paragraph format.

Author, D. E. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.

Author, F. G., & Writer, X. Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the APA Publication Manual, 5th edition, for specific instruction on this. Double space the reference list. Use the same font size and style as the main text of the manuscript.

Author, H. I. (year). As much as possible, use recent, primary sources. Authors might be asked to shorten very long reference lists.
PREPARATION OF OPTIONAL MANUSCRIPT ELEMENTS

APPENDICES
Appendixes are discouraged. If included, appendixes should be placed in the main manuscript document following the reference list, and before any tables. Appendixes must be referred to in the text.

TABLES
See the sample table, below.

QHR neither creates nor revises tables; this is the responsibility of the author.

Refer to APA for any needed formatting instruction not contained in these Guidelines.

Tables organize relevant, essential data that would be too awkward or too lengthy to include in the text, and should be used only to provide data not already included in the text. For example, participant demographics take less space presented in a descriptive paragraph than they do as a table.

Tables are to be accompanied by both their number (Table 1, Table 2, and so forth) and their title (required).

Table placement is mentioned in the text, but the tables themselves are placed at the very end of the document. The author should designate placement of each table within the manuscript by entering (flush left, on a separate line between paragraphs), INSERT TABLE 1 ABOUT HERE. *Tables are generally placed following the paragraph in which they are first mentioned.*

Create the table the way it should appear when published, then double space all text, including column headers and notes.

Use Gill Sans font for table numbers, titles, content text, and any explanatory notes. Use 8- or 9-point font (not both) for table content text and explanatory notes.

“Hide” all vertical lines and all horizontal lines except the following: top line of table, bottom line of table, and line below the main column headers. Multiple tables within the same manuscript should be similar in appearance and design.

**DO**

– make sure that what you are trying to create actually is a table; all tables must have column headings, and at least two (2) columns.

– put each table on a separate page (not in a separate document).

– use only portrait orientation for your tables.

– include only necessary data.

– ensure that all abbreviations are explained in the notes.

– ensure that the table is clear and comprehensible even without the surrounding article text (it should be able to “stand alone”).

– make your table titles concise and descriptive.

– set double spacing with formatting specifications, rather than manually inserting line breaks with the “enter” key.

– keep it neat; text alignment, spacing, and consistency of style are all important.

– keep it simple, without unnecessary columns, lines, and text.

– keep it as small as possible; use only the space necessary to contain your data. To fit within a single column of the journal, the table should be no wider than 2.95 inches; to fit across both columns it should be no wider than 6 inches. Narrow the table columns to eliminate unused “white” space.

– place explanations, clarifications, citations, symbol and abbreviation identification, and other “nondata” information in notes below the table.
Do NOT  
– use shading or color, or overuse bolding and/or italics (which can make a table look “busy” without enhancing it in any way); do not use bolded lines or bolded/wide arrows.  
– list participants individually; instead, present group characteristics.  
– set tables in landscape orientation.  
– use bullets or numbered lists in tables.  
– make simple lists into tables; instead, place the lists in the manuscript.

Sample table:

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Data</td>
<td>Data</td>
</tr>
</tbody>
</table>

Table 1. Name of the Table, Bolded, in Title Case

Secondary line of data

Data a Data Data

Data Data Data

Data Data Data

a Place notes here  
b Second note

FIGURES  
See the sample figure, below.

Like tables, figures should be used sparingly, and only when it is necessary to clarify complex relationships or concepts.

Use Gill Sans font for the figure number, title, text, and notes (if any).

Figure placement should be mentioned in the manuscript text, but each figure is to be submitted in a separate document, with the figure number (Figure 1, Figure 2, and so forth) and figure title on the first page, followed by the figure itself on the second page. Figure titles should be concise and descriptive.

The author should designate placement of each figure within the manuscript by entering (on a separate line between paragraphs) INSERT FIGURE 1 ABOUT HERE. Figures are generally placed following the paragraph in which they are first mentioned.

Note that it is usually not necessary to place your figure inside a “box” or “frame.”

Detailed formatting guidelines for figures are contained in the APA Publication Manual, but note that regular Word.doc documents are strongly preferred over .jpg or other document types, and are easier to revise, if necessary.

See APA for requirements regarding the use of copyrighted (previously published) material.
DO

– use only Gill Sans font for figure numbers, titles, text, and notes (if any).
– put each figure in a separate document.
– use only 8- or 9-point font for figure text and notes.
– make sure your figure is created to be read from left to right, from top to bottom—no exceptions.
– use sufficient space between figure elements to ensure clarity, but do not include unnecessary “white space.”
– make sure that hand-drawn figures (such as participant artwork) are dark enough to reproduce clearly when published.
– use bolding and italics sparingly, and underlining only if absolutely necessary.
– place your figure number and title on the first page of the figure document.
– place the figure itself on the second page of the figure document.
– make sure your figures have “crisp,” clean lines and text. Fuzzy, sloppy figures are not acceptable. **Scanned figures are rarely acceptable.**
– keep figures simple, with as few lines, boxes, and arrows as possible. The style of the various elements of your figure must be consistent. Keep figures neat, being especially careful about spacing and alignment of various elements, including beginnings and endings of lines and arrows.
– be aware that QHR does not publish in color; hand-drawn artwork and all photographs will be published in black and white only.

Do NOT

– double space text within figures.
– use shading or color.
– include your figures in the main manuscript document.

Sample figure, p. 1:

**Figure 1.** Name of figure here, in sentence case

Sample figure, p. 2:
INSTRUCTIONS FOR ACCEPTED MANUSCRIPTS

If your manuscript has been accepted (“accepted, pending minor revision”), the instructions for placement of certain manuscript elements will differ from those for manuscripts under review.

When preparing your final manuscript, compile and submit the various manuscript elements in the following order:

1. **TITLE PAGE**  
   *Required*  
   Insert your title page at the very beginning of your manuscript, before the abstract page; **do not submit it as a separate document.**
   
   Move other elements from the title page to other places, as instructed below, leaving only the following on the title page (in this order):
   
   - Running header
   - Article title
   - Author names
   - Author affiliations
   - Corresponding author information

2. **MAIN MANUSCRIPT TEXT**  
   *Required*  
   Start the main manuscript text at the top of the page after the abstract and keywords page.

3. **ACKNOWLEDGMENTS**  
   *Optional*  
   At the end of the manuscript text, simply hit "enter" (or "return"), and begin the acknowledgments (if any), with the heading and text on separate lines.

4. **AUTHOR’S NOTE**  
   *Optional*  
   At the end of the acknowledgments (or the end of the manuscript text, if there are no acknowledgments), hit “enter” and begin the author’s note (with heading and text on separate lines).

5. **DECLARATION OF CONFLICTING INTERESTS**  
   *Required*  
   At the end of the author’s note (or acknowledgment, if there is no author’s note, or the end of the manuscript, if there are neither acknowledgments nor author’s notes), hit “enter” and type the conflicting interests heading and appropriate statement (on separate lines).

6. **FUNDING**  
   *Required*  
   At the end of the conflicting interests statement, hit “enter” and place the funding heading and appropriate statement on separate lines.

7. **NOTES**  
   *Optional*  
   At the end of the funding statement, hit “enter” and place the note heading and numbered notes on separate lines.

8. **REFERENCES**  
   *Required*  
   Begin the references on a new page (but not in a separate document).

9. **APPENDIXES**  
   *Optional* [published at the discretion of the editor]
   Begin each appendix on a separate page, with an appropriate appendix number (or just “Appendix” if there is only one), followed by the name of the appendix (required).

10. **BIOS**  
    *Required*
At the end of the references, hit “enter” and place the biographical statements, one per line. You might need to highlight the bios, go to Format > Paragraph, and select “none” if your bios appear in hanging paragraph format.

11. **TABLES**  
    *Optional*  
    Place each table on a separate page after the bios.

12. **FIGURES**  
    *Optional*  
    Figures are to be submitted *in separate documents* (one figure per document), and formatted as describe in the “Figures” section, above. Name each figure document with its figure number, i.e., “Figure 1.”
Note: To conserve space in the Guidelines, single horizontal lines represent page breaks; double horizontal lines represent the start of a separate document

Running Head: Short Title of the Article

Abstract

Begin your abstract flush left at the top of the page, immediately below the abstract heading; do not indent the first line. The abstract may be up to 150 words in length. The entire abstract should be contained within a single paragraph. Do not add section headings or break the abstract into sections. Do not include citations in the abstract. Do not show the word count. Do not repeat the text of the abstract in the main manuscript text.

Keywords

[cite examples] cancer; cancer, breast; cancer, psychosocial aspects; embodiment/ bodily experiences; lived experience; women’s health

After the opening paragraph, indent the first line of all new paragraphs (those that do not follow headings) by .5 inches. Create this indentation by formatting the paragraph style (Format > Paragraph); do not indent the line with the tab key. Do not leave line breaks between paragraphs. Instead, continue with regular double spacing.
Level-1 Heading

Begin the next paragraph immediately after the heading. Level-1 headings are set flush left, bolded, in title case, and Gill Sans font. Xxxxxxxxxxxxxxxxxxxxxxxxx. Xxxxxxxxxxxxxxxxxxxxxxxxx xxxxxxxx xxxxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx. Xxxxxxxxxxxxxxxxxxxxx xx xxxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx x xxxxxxxxxx xxxxxxxxxxxxxxxxx (refer to the APA Publication Manual for specific information on how in-text citations are to be prepared).

INSERT TABLE 1 ABOUT HERE

Level-2 Heading

Begin the next paragraph immediately after the heading. Level-2 headings are set flush left, italicized, in title case, and Gill Sans font. Xxxxxxxx xxxxxxx x xxxxxxxx. ¹ Xxxxxxxxxxxxxxxxxxxxxxxxx xx xxxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx. Xxxxxxxxxxxxxxxxxxx xx xxxxxxxxx xxxxxxxx xxxxxxxx x xxxxxxxxxx xxxxxxxxxxxxxxxx. Xxxxxxxx xxxxxx xxx xxxxx xxxx xxxxxxxxx xxxxxxxx xxxxx xxx x xxxxxxxxxxxxxxxxxxxxxxxxxxx xxxxxxx xxxx xxxxxx xxxxxxxx xxxxxx xxxxxx.

Level-2 Heading

Xxxxxxxx xxxxxxxxxx xxx. Xxxxxxxxxxxxxxxxxxxxxxxxx xxxxxxxx Xxxxx x xxxxxxxx xxxxxxxx xxxxxxxxxxxxxxxxxxxxx xxxxxxxxxx xxxxxxxx. Xxxxxxxxxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx. Xxxxxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx x xxxxxxxxxx xxxxxxxxxxxxxxxx. Xxxxxxxx xxxxxxxxxx xx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx:

This is a sample excerpt (also known as a block quote). The entire quote should be indented by .5 inches (the first line is not indented further). Indent the quote by using Word’s Format > Paragraph function. You may also format the indentation by highlighting the desired text, and clicking on the “Increase Indent” icon on the toolbar; do not use tabs to prepare block quotes.²

Do not use quotation marks with excerpts. The text of the block quote should be in the same font style and size as the regular manuscript, and should not be italicized. Leave a blank line after each block quote/excerpt. Leave a blank line between excerpts if you present two or more in a row.
Level-3 heading. Level-3 headings are set flush left, italicized, in sentence case, in Gill Sans font, and followed by a period. They follow immediately after the preceding paragraph, without additional line breaks. Note that the paragraph text begins immediately after the heading, on the same line. Xxxxxxxxxxxxxxxxxxxxxxxxxx

Level-1 Heading

Level-2 Heading

INSERT FIGURE 1 ABOUT HERE

Level-3 heading. Level-3 headings are indented by .5 inches, italicized, in sentence case, in Gill Sans font, and followed by a period. Note that the text of the first paragraph under this heading follows immediately after the heading, on the same line, rather than beginning on the next line. Xxxxxxxxxxxxxxxxxxxxxxxxxx
Acknowledgments

We thank our research assistants, name, name, and name for their invaluable contributions to the study.

Authors' Note

Portions of this article were presented at the 10th Annual Health Care Conference, August 1, 2009, in Salt Lake City, Utah.

Declaration of Conflicting Interests

The authors declared no conflicts of interest with respect to the authorship and/or publication of this article.

Funding

The authors received no financial support for the research and/or authorship of this article.

Notes

1. Text of first note. Do not format numbered bullets. Simply type the number, followed by a period and a space.
You may include properly formatted citations in the notes, as appropriate.
2. Text of second note. Remember to include a corresponding superscript number in the text (after the ending punctuation, please) for each footnote.
3. Text of third note (and so forth). Do not use Roman numerals for footnotes.

References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented by .5”). Use Format > Paragraph rather than tabs to create the hanging paragraph format.

Author, D. E. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.

Author, F. G., & Writer, X. Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the APA Publication Manual, 5th edition, for specific instruction on this. Double space the reference list. Use the same font size and style as the main text of the manuscript.

Author, H. I. (year). As much as possible, use recent, primary sources. Authors might be asked to shorten overlong reference lists.

Appendix 1

Name of Appendix
Appendix text. xxxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
QHR Keyword List

Note: We recommend reading the entire list to identify all relevant keywords.
Remember that the keywords might not be listed exactly the way you think of them
(the specific words and the order of words might be different).

Aboriginal people, Australia
Aboriginal people, North America
abortion
abuse, domestic
abuse, emotional
abuse, physical
abuse, sexual
action research
addictions
adherence
administration
adolescent mental health
adolescents
adolescents, female
adolescents, health
adolescents, high-risk behaviors
adolescents, male
adolescents, parenting
adolescents, pregnancy
adolescents, self-care
adolescents, sexuality
adult education
aesthetic analysis
Afghanistan, Afghans
Africa
Africa, West
African Americans
aging
alcohol and alcoholism
Alzheimer’s disease
anesthesia
animal-human interactions
anorexia
anthropology
anthropology, medical
anthropology of health
anthropology of the body
art
art therapy
arthritis
arts-based research
Asia
Asia, Southeast
asthma
attachment/bonding
attention deficit-hyperactivity disorder (ADHD)
autism
autoethnography
Bangladesh
behavior
behavior, change
behavioral intervention
bereavement
biographical analysis
biomedical culture (risk)
bipolar disorder
bisexuals
Black feminism
blood
body image
boundaries
brain injury
Brazil
breast cancer
breast cancer, hereditary
breast cancer, screening
breastfeeding
bulimia
burn injury, burns
burnout
campus health
cancer
cancer, BRCA1
cancer, BRCA2
cancer, breast
cancer, genetics
cancer, oral
cancer, prevention
cancer, psychosocial aspects
cancer, screening
care, acute
care, critical
career transitions
caregivers
caregiving
caregiving, community-based (home care)
caregiving, informal
Caribbean people
case studies
case-scenario analysis
cerebral palsy
chaos
checklists
chemotherapy
childbirth
childbirth, older mothers
childbirth, relation to culture
children
children, abuse of
children, disability
children, female
children, growth and development
children, illness and disease
children, male
children, of substance users
China, Chinese people
Chinese culture
chronic illness
chronic illness, early onset
clinical research
clinical supervision
CNAs
coding
cognition
Colaizzi
collage
combined methods
comfort
comforting
communication
communication, breaking bad news
communication, doctor-patient
communication, intergenerational
communication, medical
communication, nurse-patient
community and public health
community capacity and development
community interventions
community partnerships
community-based programs
comparative analysis
complementary methods
complexity
compliance
concept analysis
concept development
concept mapping
confidentiality, participant
confidentiality, patient
conflict management
congestive heart failure (CHF)
congestive obstructive pulmonary disease (COPD)
constant comparison
constructivism
consumerism, medical
content analysis
context analysis
contraception
controversies
conversation analysis
coping and adaptation
counseling
counter culture
courage
crisis management
critical incident technique
critical methods
cross-cultural nursing
Cuba, Cubans
cultural competence
culture
cystic fibrosis
data collection and management
data mining
deafness
death and dying
decision making
decision making, clinical
delirium
Delphi
Dementia
Denmark, Danish people
depression
descriptive methods
developing countries
diabetes
diaries
dietetics
dignity
dimensional analysis
disability
disability, developmental
disability, learning
disabled persons
discharge planning
disclosure
discourse analysis
disparities, health care
disparities, health care, age
disparities, health care, gender
disparities, health care, racial
disparities, health care, sexual orientation
disfigurement
distress
Down syndrome
drama
dramaturgical analysis
dreams
Eastern European (Slavic) people
eating disorders
ecological sustainability
economics
education
education, online
education, professional
education, special needs
email interviewing
emancipatory research
embodiment/bodily experiences
emergencies
emergency medical services
emergency room
emotion work
emotional awareness
emotions
empathy
empowerment
end-of-life issues
enduring
environment
epidemiology
epilepsy  
epistemology  
erectile dysfunction  
ethics  
ethnicity  
ethnography  
ethnography, focused  
ethnography, institutional  
ethnography, rapid  
ethnography, women’s health  
ethnoscience  
ethnosemantics  
ethology  
euthanasia  
evaluation research  
event analysis  
evidence-based practice  
exercise  
exhaustion disorder  
existental approaches  
experiential methods  
exploratory methods  
factor analysis  
falls, falling  
families  
families, caregiving  
families, dual earners  
families, high-risk  
family medicine  
family nursing  
fathers, fathering  
feminism  
fertility  
fibromyalgia  
field methods  
Finland, Finnish people  
focus groups  
France, French people  
Gadamer  
gay and bisexual men  
gays and lesbians  
gender  
genetics  
geriatrics  
Giorgi  
grief  
grounded theory  
group interaction  
Haiti, Haitians  
healing  
health  
health and well-being  
health behavior  
health care  
health care, access to  
health care, cost  
health care, culture of  
health care, decision making  
health care, history  
health care, interprofessional perspective  
health care, outcomes  
health care professionals  
health care professionals, moral perspectives  
health care, provider perspective and behavior  
health care, remote  
health care, rural  
health care, teamwork  
health care, users’ experiences  
health care, workplace  
health concepts  
health, determinants of  
health education  
health, experiences  
health informatics  
health information seeking  
health insurance  
health outcomes  
health promotion  
health policy  
health seeking  
hearing  
heart attack (MI)  
heart health  
Heidegger  
hepatitis C  
hereditary diseases  
hermeneutic phenomenology  
hermeneutic philosophy  
hermeneutics  
heuristic techniques  
historical methods  
history  
HIV/AIDS  
HIV/AIDS, clinical  
HIV/AIDS, prevention  
holistic care  
holistic perspectives  
home visiting  
homelessness  
hope  
hormone replacement therapy  
hospital administration  
hospitalization  
human development  
human resources  
humanistic perspectives  
humor  
Huntington’s disease  
Husserl  
hybrid models  
hypertension  
ideal-type interpretation  
ilness and disease  
ilness and disease, acute  
ilness and disease, endemic  
ilness and disease, experiences  
ilness and disease, infectious  
ilness and disease, life-threatening  
ilness and disease, progressive
Munchausen syndrome by proxy
musculoskeletal disorders
myths
narrative analysis
narrative methods
narrative representation
narrative therapy
narratives, visual
naturalistic inquiry
nausea
Navajo people
needle exchange programs
needs assessment
negative case analysis
nephrology
Netherlands
network analysis
neurology
neuropsychology
neuroscience
Nigeria
nonprofessionals, education
Northern Ireland
Norway, Norwegians
nurse practitioners
nurses, substance use
nursing
nursing homes
nursing, administration
nursing, advanced practice
nursing, as art
nursing, children
nursing, community
nursing, counseling
nursing, education
nursing, history
nursing, hospital/community interface
nursing, maternity
nursing, outpost
nursing, palliative care
nursing, parent-child
nursing, pediatric
nursing, philosophy
nursing, psychiatric
nursing, psychosocial
nursing, sociology of
nursing, theory
nursing, transcultural
nursing, working environment
nutrition
nutrition, behavior and change
NVivo
obesity
observation
observation, nonparticipant
observation, participant
occupational health
occupational therapy
Old Order Amish
older people
older people, communication and health
older people, exercise
older people, home care
older people, hospitalization
older people, informal care
older people, rehabilitation
oncology
oral health/dentistry
oral history
organ donation
organizational systems
organizations
ovarian cancer
overweight
Pacific Islanders
pain
pain, chronic
palliative care
parenthood, transition to
parenting
parenting, of infants
Parkinson’s disease
participant observation
participation, social
participatory action research (PAR)
participatory evaluation
participatory research
patient complaints
patient education
patient participation
patient safety
pediatrics
pediatrics, cardiology
Peplau’s theory
performance methods
perinatal health
pharmacology
phenomenography
phenomenology
Philippines
philosophy
photography
photovoice
physical activity
physical therapy
placebo
poetry
policy analysis
policy development and analysis
political economy
politics
population health
positivism
postcolonial theory
postdischarge care
postmodernism
postpartum care
postpartum depression
postpositivism
poststructuralism
social support  
social theory  
social welfare  
social work  
sociolinguistics  
sociology  
sociology, educational  
software  
sorrow, chronic  
South Africa  
South America  
special care units  
spinal cord injury  
spiritual care  
spirituality  
statistics  
statistics, nonparametric  
stigma  
stories  
storytelling  
stress  
stroke  
substance use  
suffering  
suicide  
suicide, physician-assisted  
support  
surgery  
surgical enhancement  
surveys  
survivorship  
Sweden, Swedish people  
Switzerland, Swiss people  
symptom management  
system management  
systematic reviews  
Taiwan  
Tajikistan  
teaching/learning strategies  
technology  
technology, assistive  
technology, instructional  
technology, medical  
technology, use in research  
telephone  
textual (documents) analysis  
Thailand, Thai people  
thematic analysis  
thought development  
tobacco and health  

traditional and folk medicine  
transcultural health  
transition theory  
translation  
transplantation  
transsexuals  
trauma  
triangulation  
trust  
truth telling, health care provider  
truth telling, patient  
truth telling, family  
tuberculosis (TB)  
Turkey, Turkish people  
twelve-step programs  
uncertainty  
urban issues  
validity  
values  
vан Manen  
video  
Vietnam, Vietnamese people  
violece  
violece, against women  
violece, domestic  
vision  
visual methods  
vulnerable populations  
war, victims of  
weight changes  
weight management  
wheelchair sports  
womanist theory  
woman’s health  
woman’s health, midlife  
woman’s issues  
workplace  
wound care  
writing  
young adults  
young men  
young women  
youth  
youth, at-risk  

[06 Aug 2009]
BOOK REVIEWS
BOOK REVIEWS

MANUSCRIPT PREPARATION

In all essential ways, document setup for book reviews is the same as for regular article manuscripts, except that:

1. fewer manuscript elements are needed; and
2. the manuscript elements are compiled in a different order

Compile your book review as follows, in this order:

- Book information
  • Use Gill Sans font for this section
  • Line 1: Name of book author(s)
  • Line 2: Name of book, in italics, followed by the city and state/country of publication and the name of the publisher
  • Line 3: Year of publication, number of pages, retail price, and the ISBN number

- Reviewer information
  • Use Gill Sans font for this section
  • Line 1: Reviewed by: (in bolded font), followed by the reviewer’s name, primary affiliation organization, and country
  • Line 2: The "DOI" number

- Review Text
  • Use Times New Roman font for this section
  • Do not indent the first line of the opening paragraph
  • Indent the first line of all subsequent paragraphs by .5 inches

- References
  • Put the References heading in Gill Sans bolded font
  • Format the reference list exactly as you would for an article, in Times New Roman font and APA style

SAMPLE BOOK REVIEW:

Abraham Lincoln

Name of the Book Springfield, IL: Log Cabin Press.

2009. 275 pp. $29.00. ISBN 0XXXXXXXXX

Reviewed by: Janice M. Morse, University of Utah, USA

"DOI:0000"
References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented by .5”). Use Format > Paragraph rather than tabs to create the hanging paragraph format.

Author, D. E. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.

Author, F. G., & Writer, X. Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the APA Publication Manual, 5th edition, for specific instruction on this. Double space the reference list. Use the same font size and style as the main text of the manuscript.

SUBMISSION

Submit your book review in the same manner as any other manuscript.
GUEST EDITORIALS
NOTE: Guest editorials are considered and published by invitation only. Do not submit unsolicited editorials.

MANUSCRIPT PREPARATION

In all essential ways, document setup for editorials is the same as for regular article manuscripts, except that:

1. fewer manuscript elements are needed; and
2. the manuscript elements are compiled in a different order

Compile your guest editorial as follows, in this order:

- Editorial title, in bolded Gill Sans font
- In Gill Sans font, name of the guest editor, with a superscript “1” linking to the corresponding author information
- In Gill Sans font, superscript number (1), followed by the guest editor’s primary affiliation, city, state (or province; spelled out), country.
- All in Gill Sans font, corresponding author information:
  - Line 1: “Corresponding Author”, bolded, and followed by a colon
  - Line 2: Name of guest editor, primary affiliation, department or division, if any, city, state (or province; use abbreviations for this), postal code, country.
  - Line 3: Email: with email address
- Text of editorial
  - Use Times New Roman font for this section
  - Do not indent the first line of the opening paragraph
  - Indent the first line of all subsequent paragraphs by .5 inches
- References
  - Put the References heading in Gill Sans bolded font
  - Format the reference list exactly as you would for an article, in Times New Roman font and APA style

SAMPLE GUEST EDITORIAL:

Title of Editorial

Janice M. Morse

1University of Utah, Salt Lake City, [note no state is necessary, because it is in the university name], USA

Corresponding author:

Janice M. Morse, University of Utah College of Nursing, Salt Lake City, UT 84112, USA.

Email: QHR-Editor@nurs.utah.edu

Xxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxx xxx xxx
xxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxx
xxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx

Xxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxx
xx xx xxxxxxx xxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxx
xx xx xxxxxxx xxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxx xxx

References

Author, B. C. (year). The references should be double spaced, using the regular margins, and formatted as hanging paragraphs (indented .5”). Use Format > Paragraph rather than tabs to create the hanging paragraph format.

Author, D. E. (year). References should have no additional space between them, and should be listed alphabetically by the last name of the first author. Do not include blank lines between references.

Author, F. G., & Writer, X. Y. (year). The content of each type of reference (article, book, edited book, online document, and so forth) must be formatted in a very specific manner. Refer to the APA Publication Manual, 5th edition, for specific instruction on this. Double space the reference list. Use the same font size and style as the main text of the manuscript.

Submission

Submit your editorial in the same manner as any other manuscript.
SUBMISSION, REVIEW, AND PUBLICATION
HOW TO SUBMIT A NEW MANUSCRIPT

Qualitative Health Research (QHR) uses an online review system that requires submitting your article through our ScholarOne Manuscripts / Sage Track Web site.

Both QHR and Sage Publications require that authors comply with specific requirements in the preparation of their manuscripts.

**DO** – review this entire document and make any needed corrections prior to submitting your manuscript.

**Do NOT** – mail or email your manuscript to the journal office; it will not be accepted for consideration.

Proper formatting and submission will speed the peer-review process for your manuscript, and will facilitate a smoother, quicker production process if your manuscript is selected for publication.

We strongly recommend that you carefully proofread your manuscript from a hard (paper) copy prior to submission. Reading aloud is often helpful.

INFORMATION TO HAVE AVAILABLE PRIOR TO SUBMISSION

Submit only Microsoft Word documents with a .doc extension; do not submit documents with .docx, .rtf, or .pdf extensions.

When submitting your manuscript, be prepared to provide the information listed below. **Note that this information is to be entered into the online system; it is not to be included in the manuscript itself, nor should it be included in your cover letter.**

Complete contact information for EVERY author must be entered into the ScholarOne Manuscripts / Sage Track system when uploading the manuscript. Although the system itself requires complete information only for the contact/corresponding author, **QHR requires complete information for all authors—without exception.**

Have the following information ready before you begin the submission process:

- The correct spelling of each complete author name (not just initials), and the proper author order. EVERY author—without exception—must be entered into the system.
- The proper form of address for each author (i.e., Dr., Prof., Mr., Ms., Mrs., Miss, and so forth)
- A verified email address for every author, without exception. **Use extreme care when entering email addresses:** many co-authors cannot be reached because the submitting author fails to enter email addresses correctly.
- Information on any conflict of interest
- Confirmation that the manuscript is original work, and has not been published or submitted for consideration elsewhere
- The number of figures in the manuscript, if any
- The number of tables in the manuscript, if any
- The total number of words in the manuscript (use Word’s Tools > Word Count function)

When entering data and submitting your manuscript online, **do not** use ALL CAPITAL LETTERS (especially for manuscript titles and author names); instead, use Title Case. **Do not** put a period (.) at the end of your title.

The corresponding author should be someone who will be available to respond promptly to communication from QHR and/or the publisher at any time in the review, revision, production, or publication processes. Corresponding authors are responsible for the timely communication of questions and decisions to all of their respective coauthors.
Submit your manuscript at http://mc.manuscriptcentral.com/qhr/. If you do not already have one, you will need to establish an Author Account and select a password to access and return to the system. (Be sure to make note of your password information for later reference.)

Upload your documents into the system in this order:
1. Title page
2. Main manuscript
3. Figures (if any, each in a separate document, in numerical order)
4. Permissions (if needed)

**DO** – make sure your main manuscript document is “blinded,” containing no author information.

TIMING OF THE REVIEW PROCESS

QHR makes every effort to expedite the peer-review process. However, in attempting to secure the assistance of our expert reviewers we must sometimes accommodate their busy schedules and await their availability. Therefore, the average time from manuscript submission to first decision is approximately three (3) months; it might be longer. Please refrain from contacting the QHR office regarding the status of your manuscript until at least three months have passed.

HOW TO SUBMIT A REVISED MANUSCRIPT

If you have been invited to revise your manuscript (including after receiving an “accepted, pending revision” decision), you will be unable to make revisions on the originally-submitted version of the manuscript. Instead, revise your personal electronic copy of the original manuscript.

**Do NOT** – use Track Changes, highlighting, bolding, strikethrough, or colored font to indicate changes.

If you are invited to submit a revision, you will receive an email message containing comments from the reviewers and/or instructions from the editor about the revisions you are requested to make. Address the reviewer comments and follow editor instructions carefully and completely when making your changes; be as specific as possible in your response. When uploading your revision, enter (into ScholarOne Manuscripts / Sage Track, under “Author Response”) your comments concerning the changes you have made. Type your comments into the system; do not upload your response comments in a separate document.

Failure to comply completely with editor instructions for revision could result in delays, the need for additional revision, or even rejection of your manuscript. If you believe it would be detrimental to the article to comply with the requested changes, state your argument in your revision comments. Following consideration, the editor’s decision will be final.

Once the revised manuscript is prepared, upload it and submit it through your Author Center:

To submit a revised manuscript, logon to http://mc.manuscriptcentral.com/qhr/ and enter your Author Center, where you will find your manuscript listed under “Manuscripts with Decisions.” In the table, under “Actions,” click on “Create a Revision.” (Your manuscript ID number will automatically be appended to denote a revision; for example, QHR-2009-1234 would become QHR-2009-1234.R1.) Follow the prompts to complete your submission.

Upload your documents in the proper order (see How to Submit a New Manuscript, above).

**Important:** Delete all earlier versions of the manuscript before completing the submission of the revision, but do not delete your title page (unless you have replaced it with an updated version) or figures (unless you have revised them or have been asked by the editor to remove them). **You must upload your own documents; do not send them to QHR for uploading.**

We ask that authors complete and submit revisions within 60 days (30 days for “accept, pending revision” decisions). The ScholarOne Manuscripts / Sage Track system is preset to automatically establish these deadlines when revision decisions are sent out. This helps to ensure that your manuscript does not become outdated during the revision process. If you are unable to meet this deadline, or if the system...
indicates that you have missed the deadline, contact QHR at QHR-Journal@nurs.utah.edu for an extension of time. Unless you have been specifically instructed to do so, DO NOT, under any circumstances, submit your revision as a “new” manuscript.

At the editor’s discretion, your revised manuscript might be sent back out for further review, usually to the original reviewers.

Accepted Manuscripts

If your manuscript has been accepted for publication (usually pending minor revisions), be sure to review the Instructions for Accepted Manuscripts, above.

Review, Decision, and Revision Process

The Main Players

- Corresponding author
- Technical editor
- Editor (and possibly a section editor)
- Expert reviewers

Steps in the Process

1. The corresponding author submits a manuscript
2. The technical editor checks the manuscript documents for general acceptability (Word.doc)
3. The editor conducts an initial, abbreviated review of the manuscript; at this point the editor can make a decision to:
   a. Send the manuscript out for peer review;
   b. Assign the manuscript to a section editor to manage the peer-review process; or
   c. Reject the manuscript because it is fundamentally unsuited to QHR and/or its readership
4. The technical editor extends invitations for qualified experts to provide a formal review of the manuscript; this includes:
   a. Entering keywords from the manuscript into the QHR database of expert reviewers
   b. Selecting reviewers whose keywords (areas of expertise) most closely match the keywords (topic areas) of the manuscript
   c. Extending invitations to prospective reviewers by email
5. The invited reviewers can choose to accept the invitation, or may decline it based on a lack of time or opportunity to conduct the review, or because their expertise is not a good match for the main topic(s) of the manuscript.
6. If the reviewer accepts the assignment, the online review system, ScholarOne Manuscripts / Sage Track, automatically sends the reviewer, via email, instructions on how to access the manuscript and submit the review. If the reviewer declines the assignment, the technical editor repeats step 4, above, until a sufficient number of reviewers have agreed to evaluate the manuscript (usually three reviewers). Depending on the time of year (because of vacations, holidays, breaks in academic schedules, and so forth), the number of qualified potential reviewers with expertise in the appropriate topic area, and the speed with which the invited reviewers respond to the invitation, this step in the process can take a significant amount of time.
7. The reviewers read through the manuscript (usually several times), and electronically submit their responses to the questions listed below. Although reviewers are asked to submit their evaluations within 30 days of accepting the assignment, circumstances might arise which preclude their meeting the deadline. No decisions can be made until the reviews are received.

Review Criteria:

- Importance of submission: What are the manuscript’s strengths? Is it significant? Does it contain new and unique information?
Theoretical evaluation: Is the manuscript logical? Is the theory parsimonious? Complete? Useful?

Methodological assessment: Inductive approach? Appropriate method and design? Is the sample appropriate and adequate? Are data saturated? Theoretical analysis? Linked with theory and/or praxis?

Adherence to ethical standards?

Manuscript style and format: Please evaluate writing style, organization, clarity, grammar, appropriate citations, etc. Is the manuscript unnecessarily long?

Other Comments: Please give specific advice to the author(s) on how to improve the manuscript.

8. When all reviews of a particular manuscript have been received, the technical editor provides them to the editor, along with the manuscript, for consideration and a decision.

9. Based on the reviews received, and the editor's own evaluation, the editor makes a decision on the manuscript. Possible decisions include:
   a. acceptance of the manuscript for publication
   b. provisional acceptance of the manuscript, pending specific revisions based on editor and/or reviewer comments, and specific formatting and content requirements of the journal
   c. an invitation to revise the manuscript in response to reviewer comments and suggestions, to address formatting and content requirements of the journal, and to resubmit it for further consideration
   d. rejection of the manuscript, possibly with recommendations for improving it in readiness for submission elsewhere

10. The technical editor sends the editor's decision, via email, to the corresponding author. (Note: The decision will be sent as soon as it is possible to do so. Please do not send requests for "quick" decisions because of pending reviews, or because you are updating your CV.)

11. The corresponding author reviews the decision letter with any coauthors. If invited to submit a revision, either for publication or for further consideration, the author(s) can choose to accept or decline that invitation. If they accept, they revise the manuscript as instructed, and submit it.

12. The editor reviews the revised manuscript, and makes one of the following decisions:
   a. Accept the manuscript for publication
   b. Send the revision back out for peer review (beginning the process again, usually with the original reviewers providing the new evaluation)
   c. Invite the author(s) to make further revisions, either with provisional acceptance for publication, or for further consideration
   d. Reject the manuscript

A note about the decision letter: If you receive an email decision letter indicating that your manuscript is “not suitable for publication in QHR”—even if suggestions are provided for improving the manuscript—your article has been rejected.

"Reject" decisions are sent only if, in the editor's opinion, the manuscript cannot be adequately revised so as to make it suitable for publication in the journal. Therefore, please do not contact QHR with appeal requests unless you believe there has been a clear and significant misunderstanding about the content of your manuscript.

Any author is welcome to significantly revise a rejected manuscript and submit it as a new manuscript, with a new manuscript ID number.

13. The technical editor sends the decision to the corresponding author. If the manuscript is accepted, the technical editor places it in the production queue.

Reasons for “Revise” and “Reject” Decisions

Whether or not an author receives a “revise” or “reject” decision depends on

1. the nature of the reviews and the magnitude of the changes required

57
2. whether or not it is possible to correct the manuscript sufficiently to make it suitable for publication
3. how much QHR has recently published on a particular topic (or how much is currently queued for publication)

TIMING OF PUBLICATION

In a general sense, QHR publishes articles according to when they were accepted, not according to when they were first submitted. In other words, manuscripts accepted first are generally published first. Deviations from this general practice can and do occur, however, primarily because of (a) space restrictions within a particular issue, or (b) because certain articles are grouped and published together in special themed issues.

At any given time there are many accepted articles in the production queue. Therefore, it is unlikely that your accepted article will be published immediately after being accepted. It is not possible to know how many pages an article will need until the article is actually “set” by the typesetter. Many factors influence the length of a set article, including number of words, number of headings, number and length of paragraphs, use of tables and figures, and much more. Because the journal has a limited number of pages available for each volume, this sometimes causes individual articles to be “pulled” from their anticipated placement in a particular issue, and to be replaced by articles that best fit the number of pages available.

For these and many other production-related reasons, it is not possible for QHR to accurately forecast a publication date for your article. The production process is a long one, and articles are not published until at least 3 or 4 months after the edited version of the manuscript has been approved by the author. Therefore, we appreciate your cooperation in refraining from making frequent inquiries about the publication date.

PRODUCTION

When your accepted article has been tentatively assigned to an upcoming issue of the journal, your manuscript will be edited to conform to QHR and Sage publication style and standards, and sent to you for your approval and correction. There will be a very short deadline for responding to any queries posed by the copyeditor (usually about 3 or 4 days), and it is critical that your response be clear, complete, and timely. At this stage of the production process, time is of the essence.

➔ The editing stage is the time to make any substantive revisions to the manuscript; do not wait for the proof.

Following receipt of your response, the copyeditor will finalize your manuscript and submit the article to Sage Publications. Within a few weeks (usually about 2 to 4 weeks) you will receive a typeset proof of the article. Again, it is critical that you read the proof carefully and respond to Sage’s production editor by the deadline given. Clearly specify any needed corrections.

➔ The proof stage is intended only for minor corrections. Do not ask the Sage Publications production editor to undo corrections or revisions made at the editing stage.

Note: Requested changes that are contrary to QHR and Sage publication style will not be incorporated.

PUBLISH AHEAD OF PRINT

Sage Publications, Inc., the publisher of QHR, provides a special feature called OnlineFirst. Through this feature, completed articles (those for which the production process has been completed) are published online before the print versions are available. These articles are both accessible and citable prior to the publication of the printed journal issue. For more information about OnlineFirst, visit http://online.sagepub.com/sphelp/SageColl_PAP.dtl.
POLICY ON NIH PUBLICATION REQUIREMENTS

The following information was received from Sage Publications on May 29, 2008, and is included herein by permission of Sage Publications:

“We have received a significant number of inquiries from journal authors [about] our policy regarding NIH compliance, which mandates that the final, peer-reviewed manuscripts, upon acceptance for publication, be made publicly available no later than 12 months after the official date of publication.

“The NIH policy meets our own posting policy at the first anniversary of the date of the NIH-funded article’s publication. As stated on the contributor agreement, our policy is as follows:

“No sooner than twelve (12) months after publication of the Contribution in the print edition of the Journal, the Contributor-created version of all or part of the Contribution and abstract as accepted for publication by the Journal (i.e., updated to include all changes made during the peer-review and editing process) may be posted on any non-commercial Web site or repository, provided that such electronic copy includes a hyperlink to the published version of the Contribution on the SAGE Journals Online Web site, together with the following text: ‘The final, definitive version of the article is available at http://online.sagepub.com/.’ Contributor is not permitted to post the SAGE PDF version of the published Contribution on any Web site or repository.

“Authors asking about the NIH requirement should be advised that they are free to provide their own author-created copies of the peer-reviewed version of the article to PubMedCentral and other public repositories with the understanding that the article will not be made available until 12 months after publication.”
PERMISSIONS
EXCLUSIVE LICENSE TO PUBLISH

Sage Publications requires a completed and signed Exclusive License to Publish (ELP) form from the author(s) of every article, keynote address, book review, letter to the editor, or other material published in QHR. It is to be submitted to QHR when notice is received that the article has been accepted for publication.

The ScholarOne Manuscripts / Sage Track system will be triggered to send you ELP information (via email), including instructions to access and complete the form, immediately after an “accept” decision is sent to you. If you do not receive this notification, or if you accidentally delete it, you may request a blank ELP form by contacting QHR at QHR-Journal@nurs.utah.edu. Under these circumstances, please take the steps listed below to submit your form:

Print the form, complete and sign it, and submit the first 2 pages only to QHR by one of the following methods (please write your manuscript ID number in the upper right corner of the form, e.g., QHR-2009-0XXX):

By email (preferred): Scan the completed form, save it to your computer, and send it as an attachment to: QHR-TE@nurs.utah.edu.

By facsimile: Fax the completed document to: 801-355-3850; Attention: Dori Fortune. (If you use this method, please send an email alerting us to the pending arrival of the fax.)

- Note that the corresponding author completes and signs the form on behalf of all coauthors of a particular manuscript; it is not necessary to obtain the signature of each author. Remember that all author names must appear on the first page of the form. Please print legibly!
- Submit only the first 2 pages of the completed form.
- Do not submit a completed Exclusive License to Publish form unless and until you receive word that your manuscript has been accepted for publication.

COPYRIGHT PERMISSION

If your article contains any material (text, tables, or figures) that has been published previously—even if you were the author—you might need to obtain permission to use the material in your article. For guidelines on reprint permission requirements, visit http://www.sagepub.com/repository/binaries/guidelines/PermissionsGuidelines.pdf.

Accepted articles requiring copyright permission will not be submitted to the publisher until written permission from the copyright holder is received by QHR from the author (electronic submission—such as a scanned document—is acceptable).

If permission is necessary, we strongly recommend that you submit your request at the earliest possible date, because the process is frequently lengthy.

Permission must be requested from the holder of the copyright, which is usually the publisher, not the author or journal.

If you do need to request reprint permission (from Sage Publications or any other publisher), you may download a generic request template at the following URL: http://www.sagepub.com/repository/binaries/RequestForPermissionForm.pdf

Submit the written reprint permission along with the original manuscript submission or, if submitted later, submit it to QHR (be sure to refer to your manuscript ID number):

By email: Send it to QHR-TE@nurs.utah.edu

By facsimile: Fax it to 801-355-3850, Attention Dori Fortune

To request copyright permission from Sage Publications (for articles published in QHR), do not contact QHR. Access the article online on the journal’s Web site at http://www.qhr.sagepub.com and select the “Request Permission” link. Permission may also be requested by contacting the Copyright Clearance Center via their Web site at http://www.copyright.com, or via email at info@copyright.com.